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How to compare data in two different excel sheets

How to compare data in two different excel sheets using vlookup.

Watch videos & € "Compare two columns in Excel for matches and differences The only question I receive a lot is: 4 € ceHow compare two columns in Excel? A €. This can be done in many different ways, and the method to use will depend on the data structure and what the user wants from it. For example, you can want to compare two columns and
find or highlight all the corresponding data points (which are in both columns), or only the differences (where a data point is in a column and not in the other), etc. From I asked myself so much, I decided to write this massive tutorial with the intention of covering most (if not all) possible scenarios. If you find this useful, pass it to other Excel users.
Note that the techniques to compare the columns shown in this tutorial are not the only ones. Based on your data set, you may have to change or change the method. However, the basic principles would remain the same. If you think there is something that can be added to this tutorial, let me know in the comments section Compare two row
correspondence columns This is the simplest form of comparison. In this case, it is necessary to make a row for row comparison and identify which lines have the same data and which ones are not. Example: Compare cells in the same row below is a set of data in which I have to check if the name in the column A is the same in column B or not. If there
is a game, I need the result as a € ceTruea €, and if it doesn't match, then I need the result as & € cefalsea €. The following formula would do this: = A2 = B2 Example: Compare cells in the same line (using IF formula) if you want to get a more descriptive result, you can use a simple IF formula to return & € ceMatcha € when i Names are the same and
a € eemammatcha € when the names are different. Translation: Note: If you want to make the case of sensitive comparison, use the following IF formula: = if (EXACT (A2, B2), "Match", "MISMATCH") with the above formula, 'IBM 'It is IBM' would be considered two different names and the formula mentioned above would return 'mismatch'. Example:
highlights the rows with the correspondence data if you want to highlight the rows that have corresponding data (instead of obtaining the result in a separate column), you can do it using conditional formatting. Here are the steps to do this: select the entire data set. Click on the 4 € ceHomea € ™ tab. In the Styles group, click on the 'Conditional
Training' option. From the drop-down menu, click "New Rule". In the "New Formatting Rule" dialog box, click "Use a formula to determine which format cells". In the formula field, insert the formula: = $ A1 = $ B1 Click the button format and specify the format you want to apply to the corresponding cells. Click OK. This will highlight all the cells in
which the names are the same in each row. Compare two columns and first floor games if you want to compare two columns and highlight the corresponding data, you can use the duplicate functionality in conditional formatting. Note that this is different from what we have seen when comparing each row. In this case, we will not make a row for a
row comparison. Example: compare two columns and highlights often correspondence data, you will get dataset where there are matches, but these may not be in the same row. Something as shown below: note that the list in the column A is larger than that in B. even some names are present in both lists, but not in the same line (like IBM, Adobe,
Walmart). If you want to highlight all the corresponding company names, you can do it using conditional formatting. Here are the steps to do this: select the entire data set. Click on the Home tab. In Styles, click on the 'Conditional Training' option. Hover the cursor on the Highlight Cell Rules option. Click Duplicate Values. In the Duplicate Values
dialog box, make sure that 'duplicate’ is selected. Specify formatting. Click OK. The above steps would give you the result as shown below. Note: The conditional formatting rule is not sensitive. So A ¢ 4,— 8 "appleA ¢ 4,— 4" ¢and A, A, A, A, A, A, A, A, A A A A A A4 is,AA A A A A A A, a€ e is considered the same and would be highlighted as
duplicates. Example: compare two columns and highlights the non-corresponding data if you want to highlight the names in a list and no other, you can also use conditional formatting for this. Select the entire data set. Click on the Home tab. In the Styles group, click on the option A, A «Formatting formatting". Switches the cursor to the option of
highlighting cell rules. Click on duplicate values. In the Duplicate Values dialog box, make sure that 4,— A "unique ¢ &4,— &" ¢ is selected. Specify formatting. Click OK. This will give you the result as shown below. Highlights all cells that have a name that is not in the other list . Compare two columns and find missing data points if you want to identify
if there is a data point from a list, you need to use the search formulas. Suppose we have a data set as shown below and you want to identify companies present in column a but not in column b, to do so, I can use the following VLookup formula. = Iserror (VLookup (A2, $ B $ 2: $ B $ 10,1,0)) This formula uses the VLookup function to check If a
company name in A is present in column B or less. If it is present, return that name from column B, otherwise return an error # n / a. These names returning the error # n / a are those left in column B. The Iserror function returns true if there is The VLookup result is a mistake and false if it is not a mistake. If you want to get a list of all the names in
which there is no match, you can filter the results column to get all the cells with True. You can also use the correspondence function to do the same; = Non (Isnumber (Match (A2, $ B $ 2: $ B $ 10.0))) Note: Personally, I prefer to use the matching function (or the index / match combination) instead of VLookup. I find it more flexible and powerful.
You can read the difference between VLookup and Index / match here. Compare two columns and pull the corresponding data if you have two data sets and you want to compare items to another list and retrieve the corresponding data point, you need to use the search formulas. Example: pull the corresponding data (exact) for example, in the list
below, I want to recover the market evaluation value for the column 2. To do what, I need to look for that value in column 1 and then take the corresponding evaluation of the Value market. Below is the formula that will do it: = VLookup (D2, $to $ 2: $ B $ 14.2.0) or = index ($ to $ 2: $ B $ 14, match (D2, $ a $ 2: $ to $ 14, 0), 2) Example: Pull the
corresponding (partial) data in case you get a set of data in which there is a small difference in the names in the two columns, using the formulas search described above do not work. These research formulas need an exact correspondence to give the right result. There is an approximate correspondence option in VLookup or in correspondence
function, but it cannot be used here. Suppose you have the data set as shown below. Note that there are names that are not complete in column 2 (like JPMorgan instead of JPMorgan Chase and Exxon instead of ExxonMobil). In this case, you can use partial search using wildcards. The following formula will give the right result in this case: = VLookup
(""" &D2&"", $to$2: $B$14.2.0) or =index ($ to $ 2: $ B $ 14, correspondence ("*" & D2 & "*", $to $ 2: $ to $ 14.0), 2) In the example above, the asterisk (*) is a wildcard that can represent a number any of characters. When the value of the search is flanked by both on The sides, any value in column 1 which contains the value of the search in
column 2 would be considered as a correspondence. For example, * Exxon * would be a correspondence for ExxonMobil (as * can represent any number of characters). You also like the following excel suggestions and tutorials: watch video A ¢ 4,— "How to compare two Excel sheets for differences comparison of two Excel files (or comparing two
sheets in the same file) can be difficult as an Excel workbook It only shows a sheet at the same time. This becomes harder and subject to errors when you have a lot of data that must be to be Luckily, there are some interesting features in Excel that allow you to easily open and compare two Excel files. In this Excel tutorial, I will show you multiple
ways to compare two different Excel files (or sheets) and check the differences. The method chosen will depend on how your data is structured and what kind of comparison you are looking for. Let's start! Compare two Excel sheets in Separate Excel Files (Side-by-Side) If you want to compare two separate Excel files side by side (or two sheets in the
same workbook), there is an integrated function in Excel to do so. It is the View Side by Side option. This is recommended only when you have a small set of data and manual comparison of these files is likely to be less time and error-proof. If you have a large dataset, I suggest you use the conditional method or the method of the formula later covered
in this tutorial. Let's see how to use this when you have to compare two separate files or two sheets in the same file. Suppose we have two files for two different months and you want to check which values are different in these two files. By default, when you open a file, it is likely to take the entire screen. Even if you reduce the size, you always see an
Excel file at the top. With the side-by-side view option, you can open two files and then arrange these horizontally or vertically. This allows you to easily compare values without moving back and forth. Below are the steps to align two rows side by side and compare them: Open the files you want to compare. In each file, select the sheet you want to
compare. Click on the View tab In the Windows group, click the 'See side by side' option. This becomes available only when you have two or more open Excel files. As soon as you click the View side by side option, Excel will arrange the workbook horizontally. Both files will be visible, and you're free to edit/please these files while they're arranged side
by side. In case you want to organize vertical files, click the Arrange All option (in the View tab). This will open the 'Arrange Windows' dialog box where you can select 'Vertical'. At this point, if you scroll down into one of the worksheets, the other will remain as it is. You can change this so that when you scroll into a sheet, the other also scrolls at the
same time. This makes it easier to make a line for line comparison and identify any differences. But to do this, you need to enable the Sincrone Screlation. To enable synchronous Scrap, click the View tab (in one of the workbooks) and then click the Synchronous Scrap option. This is an activation button (so if you want to turn off, simply click on it
again). Comparison of multiple sheets in separate Excel files (side-by-side) With the option 'Show side by side', you can compare only two Excel files to one go. In case you have multiple open Excel files, when you click on the View side by side option, it will show you a 'Buy side by side' dialog, where you can choose which file you want to compare with
the active workbook. In the case that you want to compare more than two files to a go, open all these files and then click the Arrange All option (it is in the View tab). In the Windows Arrange dialog box, select Vertical/Horizontal and then click OK. This will organize all Excel files open in the selected order (vertical or horizontal). Compare two sheets
(Side-by-Side) in the same Excel workbook In case you want to compare two separate sheets in the same workbook,you can use the Side View function by side (as it only works for separate Excel files). But you can still do the same side comparison. This is made possible by the ‘New Windows’ function in Excel, which allows you to open two instances
on the same workbook. Once you have two open instances, you can arrange these side by side and then compare these. Suppose we have an Excel workbook which has two sheets for two twoMONTHS (Jan and Feb) And you want to compare these side by side to see how sales have changed: Below are the steps to compare two sheets in Excel: Open
the workbook that has the sheets you want to compare. Click the View tab in the Window group, click on the option A ¢ 4,— A «<Window WindowA ¢ 4,— 4 4 4 4" ¢. This opens the second instance of the same workbook. On the tab A, 4 4 4 & "ViewA ¢ 4,— &" ¢, click on A ¢ 4,— & "Arrange all". This will open the Arrange Windows dialog box Select A ¢ &,—
A "VerticalA ¢ 4,—~ A "¢ To compare data in columns (or select Horizontal if you want to compare data in rows). Click OK. The previous steps would organize both instances of the workbook vertically. At this point over time, both folders of Work would have the same selected worksheet. In one of the workbooks, select the other sheet you want to
compare with the active sheet. How does it work when you click on the new window, open the same workbook with a name slightly different. For example, if your name of the workbook is A ¢ 4,— & "STSTA ¢ &4,— 4" ¢ and click on the new window, will call the workbook already open A ¢ 4,— ~ Test A ¢ 4,— "1" and the second instance as A ¢ 4,— 4444
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instead of doing it manually, you can use the power of conditional formatting to quickly highlight any differences in the two Excel sheets. This method is really useful if you have two different versions in different sheets and you want to quickly check what has changed. Yes Note that you cannot compare two sheets in different workbooks. Since
conditional formatting cannot refer to an external Excel file, i Sheet needed to compare must be in the same Excel workbook. In the event that these Aren, you can copy a sheet from the other file to the active workbook and then perform this comparison. For this example, suppose you have a set of data as shown below for two months (January and
February) in two different sheets and you want to quickly compare the data in these two sheets and check if the prices of these articles have changed or not . Below are the steps to do this: select the data in the sheet where you want to highlight the changes. Since I want to check how the prices have changed from January to February, I selected the
the dialog box Format in the window of Size cell dialog that appears, click on A ¢ 4,—~ ~ Fill tabA ¢ 4,— A "¢ and select the color where you want to highlight the non-corresponding data. Click OK Click OK the steps above reported highlight Any changes in the data set in both sheets. How does it work? The conditional formatting highlights a cell when
the formula given for that cell returns a real. In this example, we are comparing each cell in a sheet with the corresponding cell in the other sheet (made using the non-equal to the operator in the formula). When conditional formatting detects any difference in the data, highlights that in the Jan sheet (the one in which we have applied conditional
formatting. Note that I used relative reference in this example (A1 and not $ $to $ 1 or $ Al or $ 1 ). When using this method to compare two sheets in Excel, Excel, the following; This method is good to quickly identify differences, but you can't use it on a continuous basis. For example, if I insert a new line into any of the data sets (or delete a line), it
would give me wrong results. As soon as I enter / delete the row, all subsequent rows are considered different and highlighted accordingly. You can compare only two sheets in the same Excel file that you can compare the value (not the difference in formula or formatting). Compare two Excel files/sheets and get the differences using the formula if
you were interested only to compare quickly and identifying the differences between two sheets, you can use a formula to recover only those different values. For this method, you will have a separate worksheet where you can recover the differences. This method would work if you want to compare two Excel workbooks or separate worksheets in the
same workbook. Let me show you an example where I'm comparing two data sets in two sheets (in the same workbook). Suppose you have the data set as below screenshot shown in a sheet called Jan (and similar data in a sheet called February), and you want to know which values are different. To compare the two sheets, first, insert a new
worksheet (we list this sheet of this sheet a€ cedifferences "). In cell A1, enter the following formula: = IF (Jan! A1 Feb! A1, "Jan Value:" & Jan! A1 & Char (10) & "Evaluation Feb:" & Feb! A1, "") Copy and paste this formula For a range so that you copy the entire data set both in both sheets. Since I have a small set of data, I will cover and paste only
this formula in A1: Range B10. The above formula uses a condition to verify differences. In case there is no difference in values, it will return blank, and in case there is a difference, it will return the values from both sheets in separate lines in the same cell. The good thing with this method is that it only gives you differences and shows you exactly
what the difference is. In this example, I can easily see that the price in the cell B4 and B8 is different (as are the exact values in these cells). Compare two Excel files/sheets and get differences using VBA If you need to compare Excel files or leaves quite often, it is a good idea to have a Excel macro VBA code ready and use it whenever you need to
compare. You can also add the macro to the Quick Access toolbar so you can access it with a single button and instantly know which cells are different in different files/sheets. Suppose you have two Jan and Feb sheets and want to compare and highlight differences in Jan sheet, you can use the VBA code below: Sub CompareSheets () Dim RngCell as a
range for each rngcell in worksheets ("Jan"). Used if Non rngcell = worksheets ("" feb "). Cells (rngcell.row, rngcell.column) then rngcell.interior.color = VByellow End If later RGGCell End Sub The above code uses the next loop to pass through each cell in the Jan sheet (the entire range used) and compares it with the corresponding cell in February
sheet. In case you find a difference (which is controlled using IF-Then instruction), it highlights those cells in yellow. You can use this code in a normal form in the VB editor. And if you need to do so often, you better save this code in the personal macro workbook and then add it to the quick access toolbar. In those ways, you will be able to make this
comparison with a click of a button. Here are the steps to get the personal macro workbook in Excel (it is not available by default, so it isEnable it). Here are the steps to save this code in the personal macro workbook. And here you will find steps to add this macro code to QAT. Using a third-party tool A ¢ 4,—~ "XL comparator Another quick way to
compare two Excel files and check the games and the differences is using a free third-party tool as the XL. comparator. This is a basic tool On the web where you can upload two Excel files and create a comparison file that will have the data they are common (or different different data su quale opzione hai selezionato. Supponiamo di avere due file che
hanno set di dati del cliente (come name and indirizzo e-mail,) and si desidera controllare quickly che cosa i clienti sono c'e file 1 e non in file 2. Qui di Seguito & come confrontare due file Excel and creare un rapporto di confronto: Close . net Utilizzare 1'opzione Scegli file per caricare due file (size massima di ogni file puo essere 5MB) Clicca sul
pulsante Avanti. Selezionare la colonna comune in entrambi questi file. Lo strumento usera questa colonna comune per cercare le partite e le differenze Selezionare una delle quattro opzioni, se si desidera ottenere dati corrispondenti o diversi dati (basato su File 1 the File 2) Clicca su Next Scarica il file di confronto che avra i dati (basato su quale
opzione hai selezionato in phase 5) Di Seguito e riportato un video che mostra come funziona lo strumento XL Comparator. Una preoccupazione che si puo avere when si usza uno strumento di terze parti per confrontare i file Excel & circa la privacy. If avete dati riservati e la privacy e davvero importa per esso, &€ meglio uszare altri metodi sopra
indicati. Si noti che il sito web XL. Comparator cites che Eliminano tutti i file dopo 1 ora di fare il confronto. Questi sono alcuni dei metodi che e possibile uszare per confrontare due diversi file Excel (o fogli di lavoro nello stesso file Excel.) Spero che tu abbia trovato questo tutorial Excel utile. Ti piacera anche i seguenti tutorial di Excel: tutorial:
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